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1. Overview of Consumer Packaged Goods
Original brand manufacturers and private label manufacturers of consumer packaged goods, such
as those in the food and beverage industries or in the cleaning solution, detergent, paper product,
cosmetics, baby care, and skin care segments, contend with challenges to keep up with the trends and
demands of the ever-changing industry. They need to create new products and update existing products
and packaging based on market trends. Additionally, they must develop new products conforming with
regulatory compliance and sustainability standards and taking into account supply chain complexity,
industrial productivity, rising commodity costs, and changing customer needs.

The Consumer Packaged Goods (CPG) solution helps you to collaborate on various aspects such as
product development, recipe management, artwork, and packaging design of consumer packaged
goods.
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2. Taskflow to deploy the CPG solution
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3. Install Teamcenter for CPG using TEM
To install CPG features, you must have a Teamcenter environment installed on your machine. You
can either use an existing environment or create a new one. For detailed instructions on installing
Teamcenter, refer to Teamcenter Installation on Windows Using TEM or Teamcenter Installation on
Linux Using TEM.

Run TEM and select the appropriate options until you reach the Features panel.

From the Extensions navigation tree, select the following options:

• Supplier Relationship Management

• Vendor Management

• Consumer Products and Retail Foundation

• Brand Management to install the brand management functionality of CPG.

• Packaging and Artwork to install the packaging and artwork functionality of CPG.

• Consumer Product Management to install the product management functionality of CPG.

• Reuse and Standardization

• Classification Server

• Classification Interface

From the Business Modeler IDE Templates panel, select the following options:

• (Optional) Business Modeler IDE Templates

• Consumer Products and Retail Foundation

• Brand Management

• Packaging and Artwork

• Consumer Product Management
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4. Install CPG using Deployment Center
Add the Consumer Packaged Goods application to your existing Teamcenter environment.

Procedure

1. Log on to Deployment Center and select the environment to which you want to add Consumer
Packaged Goods.

2. Go to the Applications task. Click Add or Remove Selected Applications .

3. In the Available Applications panel, use the web browser search to find the Consumer Packaged
Goods application. Select the application, and then click Update Selected Applications.

Deployment Center automatically selects any additional dependent applications.

4. In the Selected Components list of the Components task, note any remaining components whose
configuration status is not 100%. Select each incomplete component, enter required parameters,
and save component settings until all components in the environment show a configuration status
of 100%.

When all components are fully configured, the Deploy task is enabled.

5. Go to the Deploy task. Click Generate Install Scripts to generate deployment scripts you will use
to update affected machines.

When script generation is complete, note any special instructions in the Deploy Instructions panel.

6. Locate deployment scripts, copy each script to its target machine, and then run each script on its
target machine.

For more information about running deployment scripts, see Deployment Center ─ Usage.
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5. Update the Teamcenter data model to
manage CPG Products
You can update the brand management data model to modify the Brand Equity business object of the
type Product Line into two different business objects, Brand Equity and CPG Product Line. This data
model change allows the users to create and manage CPG products under the business object CPG
Product Line. Previously, users could create the CPG product under the Brand Equity business object.

To migrate to the new brand management model:

1. Update to, or ensure that you have, the latest Teamcenter version.

2. Migrate to the new business object by running the brndmgmt_productline_migration utility.

For more information about using this utility, run the brndmgmt_productline_migration -h command
from the Teamcenter command prompt.
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6. Install or update Dispatcher
To generate point-of-sale barcodes, copy asset, and panel you must install Dispatcher as a standalone
instance or in an existing Teamcenter environment. If Dispatcher is already installed in your existing
Teamcenter environment, you must modify it to include the Asset Conversion translator.

When you install Dispatcher and select translators in the installation tool, select the Asset Conversion
translator.
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7. Configuring CPG
Overview of configuring CPG

Configure and set up CPG as follows:

• Create groups, roles, users, and projects

• Create custom classification hierarchy to organize your brand information

• Import sample GS1 classification hierarchy

• Import sample dimension values for CPG

• Map GS1 classification data and dimension values

• Set the output format for barcode image

• Configure default thumbnails for digital assets

• Set up security for digital assets

• Assign vendors for external design studios and artwork agencies

To use CPG on the rich client, you must configure the package process templates and the design and
technical templates.

Create groups, roles, users, and projects

By setting up user management, you can control the functionality that is available to users who are
mapped to a specific role, thereby controlling the access to unrestricted data. As an administrator, you
create user profiles with different roles, who form the user base of Teamcenter using Organization. You
can also manage and organize data using Projects and grant data access to project team members.

Some of the most common user roles in CPG include:

• Product manager

• Product developer

• Product designer

• Package designer
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• Formulation designer

• Artwork designer

As an administrator, you must perform the below tasks for setting up users:

• Create a group

• Create a role

• Create a user

• Add roles and users to groups

• Create a project and assign users to a project.

Create a custom classification hierarchy to organize your brand
information

You can create a custom classification hierarchy to organize your brand information using the
Classification Admin application. This application is not included with Brand Management. It requires
a separate license.

You organize your brand information by creating groups and classes to represent the brand items. For
example, you can create a group named Personal and beauty products group to organize all the classes
of beauty products used by your company, such as haircare, makeup, and skincare. You can also create
a subclass for all the classes. For example, for the class Haircare, you can create subclasses such as
shampoo, conditioner, and hair color.

Use the Classification Admin application to create the custom brand hierarchy by:

1. Creating groups to organize your brand information.

2. Creating classes in the groups to represent brand items.

Example:

For personal care products, you can create the following hierarchy:

Personal_and_Beauty_Products (Group)
   Hair_Care (Class)
      Shampoo (Subclass)

7. Configuring CPG
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      Conditioner (Subclass)
      Hair color (Subclass)
  
 

For food and beverages products, you can create the following hierarchy:

Food/Beverage/Tobacco (Group)
   Beverages (Class)
      Alcoholic Beverages (Subclass)
      Coffee/Tea/Substitutes (Subclass)
      Non Alcoholic Beverages – Not Ready to Drink (Subclass)
      Non Alcoholic Beverages – Ready to Drink (Subclass)
  

You can also modify the placement of a group within the hierarchy by changing the group's parent.

Configure default period for released SKUs filter in KPI dashboard

You can set the Pmg0ItemSKU_released_dashboard_default_timeline site preference, to set the
default period in years for the SKUs released filters in the key performance indicator(KPI) dashboard.
For example, setting the Values to 10 will set the default period of past 10 years for the SKUs released
filters in the KPI dashboard.

Import the sample GS1 classification hierarchy

Teamcenter supports the GS1 Global Product Classification (GPC) standard, which allows global trading
partners to group products in the same way universally. To import the sample GS1 classification
hierarchy into the Teamcenter environment:

1. Open the Teamcenter command prompt and enter the location where TC_ROOT, TC_DATA, and
TC_DATA/tc_profilevars are set.

2. Run the following command.

• For Windows:

plmxml_import –u=Tc-admin-user –p=password –g=group –xml_file=%TC_INSTALL_DIR%/
pmg0cpmgmt/samples/cpg_GS1_classification.plmxml -import_mode=overwrite

• For other Operating Systems:

plmxml_import –u=Tc-admin-user –p=password –g=group –xml_file=$TC_INSTALL_DIR/
pmg0cpmgmt/samples/cpg_GS1_classification.plmxml -import_mode=overwrite

Configure default period for released SKUs filter in KPI dashboard
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Import sample dimension values for CPG

You can import sample dimension values in your Teamcenter environment.

1. Open the Teamcenter command prompt and enter the location where TC_ROOT, TC_DATA, and
TC_DATA/tc_profilevars are set.

2. Run the following command.

• For Windows:

plmxml_import –u=Tc-admin-user –p=password –g=group –xml_file=%TC_INSTALL_DIR%/
pmg0cpmgmt/samples/cpg_dimensions_keylov.plmxml –import_mode=overwrite

• For other Operating Systems:

plmxml_import –u=Tc-admin-user –p=password –g=group –xml_file=$TC_INSTALL_DIR/
pmg0cpmgmt/samples/cpg_dimensions_keylov.plmxml –import_mode=overwrite

Map GS1 classification data and dimension values

To map GS1 classification data with the OOTB dimension values, you must import these OOTB sample
preferences in the Teamcenter environment.

1. Open a Teamcenter command prompt and enter the location where TC_ROOT, TC_DATA, and
TC_DATA/tc_profilevars are set.

2. Run the following command.

• For Windows:

preferences_manager –u=Tc-admin-user –p=password –g=group –mode=import –scope=SITE
–action=MERGE –file=%TC_INSTALL_DIR%/pmg0cpmgmt/samples/cpg_sample_preferences.xml

• For other Operating Systems:

preferences_manager –u=Tc-admin-user –p=password –g=group –mode=import –scope=SITE
–action=MERGE –file=$TC_INSTALL_DIR/pmg0cpmgmt/samples/cpg_sample_preferences.xml

Set the output format for barcode image

In Active Workspace, when a CPG user creates a barcode revision, the system generates the barcode
image and attaches that image to the barcode revision.

7. Configuring CPG
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You can set the barcode image output format using the PKG_barcode_output_format preference. By
default, the preference value is set to .svg. You can change the barcode image format to any of the
following supported formats:

• .svg

• .png

• .jpeg

• .gif

• .bmp

Configure default thumbnails for digital assets

Update the TC__thumbnail_relation_order preference to specify which relations to parse to find
thumbnails for the digital assets.

You must manually add the relation Pka0DgtAssetRepresentation to this preference after installing
Consumer Packaged Goods.

Set up security for digital assets

CPG users can manage a digital asset library across departments and partners by configuring security
permissions for each digital asset.

To assign digital assets to a project with specific user permissions, you must create a user's group with
external security, set the user's role, assign users to this group, and create projects with specific user
permissions (global or unrestricted) in Teamcenter Rich Client as explained below:

Create a group with external security

1. Log on to the rich client.

2. Start the Organization application.

3. From the Organization List tree, select the top-level group node.

The Groups pane appears.

Configure default thumbnails for digital assets
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4. In the Name box, type a group name and set security for group as External.

Assign roles to a group

1. Select the group node in the Organization tree to which you want to add the role.

2. In the Groups pane, click Add Role.

The Organization Role wizard appears.

7. Configuring CPG
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3. Select Add new role to the group and click Next.

The first role added to a group becomes the default role for that group.

4. Provide the required information and click Close to create the new role, or click Finish to perform
another action.

You can use the Organization Role wizard to add a new role to a group during the process of creating
the group or subgroup in the tree.

Assign users to a group

You can add a new user to the Organization tree as part of the process of creating the group or role
hierarchy.

• Select a role node from the Organization tree.

• In the Roles pane, click Add User.

The Organization User wizard appears.

• Select Add new user to the group/role and click Next.

Set up security for digital assets
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• Create the user by providing details in the Specify New User pane.

After providing the required information, click Next or Finish.

Create a project

1. Log on to the rich client.

2. In the Project application, create a new project.

3. Assign users or a group of users to the project. In the Member Selection pane, add privileged users
to the project.

4. Select World read access if you want all users to have access to view the digital assets associated
with the product. Partners will also have permissions to view the digital assets.

7. Configuring CPG

7-8  Consumer Packaged Goods ─ Deployment and Administration, Teamcenter 2412
© 2025 Siemens



CPG users can assign the digital assets to this project in Active Workspace to allow partners to view
the digital assets.

OR

Select Groups with Security to provide unrestricted access to the digital assets. Only unrestricted
users can access digital assets based on the settings.

CPG users can assign the digital asset to this project in Active Workspace to restrict the access to
internal users only.

Assign vendors for external design studios and artwork agencies

CPG users can create and manage briefs to share digital assets and other information for the
development process of packaging and artwork. This involves external design studios and artwork
agencies. The briefs are sent through a workflow to the associated vendors.

To support partner interaction for creating package and artwork designs, you must first create vendors
for external partners such as the design studios and the artwork agencies in Active Workspace or in

Assign vendors for external design studios and artwork agencies
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Rich Client. For more information on creating a vendor for external partners and assigning the project
to that vendor, refer to the Consumer Packaged Goods on Active Workspace ─ Usage help in the Active
Workspace help collection or the Consumer Packaged Goods on Rich Client ─ Usage in the Teamcenter
help collection.

After creating the vendor, you must assign this vendor a Design Studio role or an Artwork Agency role
in Rich Client.

1. Log on to the rich client as an administrator.

2. Select the vendor revision and click Tools > Vendor Management > Add Vendor Role.

3. In the Add Vendor Role dialog box, under Select Vendor Role, select the Vendor Role Name as
Design Studio or Artwork Agency from the list.

4. Click OK.

Configuring Consumer Packaged Goods for the rich client

Overview of configuring CPG for the rich client

For using the CPG features in the rich client, you must make the following configurations:

• Create an initiative folder to group all the templates.

• Create package process template

• Set up design and technical brief templates

Create an initiative folder to group templates

To manage and group all the templates you create for CPG, you can create an initiative folder in
Teamcenter.

1. Choose File→New→New Folder.

2. In the Name box, type a folder name.

3. In the Description box, type a brief explanation of the folder contents.

4. Click OK.

7. Configuring CPG
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Create a package process template

You must create a process template that tracks the various stages of the product or package
development process.

1. Create a schedule template.

2. Add tasks and milestones to the schedule template.

Set up design and technical brief templates

A design brief captures design requirements of a package, whereas a technical brief captures technical
requirements of a package. Design and technical brief templates can be created in two ways:

• Using the Systems Engineering application

• Attaching a document to a design/technical brief item revision

Create design and technical brief templates with Systems Engineering

1. Start the Systems Engineering application.

2. Click the Import a specification link in the Systems Engineering welcome pane.

3. Click the browse button (...) to display the Choose the file to import dialog box. Browse to and
select the file (design/technical brief template), and then click Import.

4. From the Spec type list, select the specification type.

Select Technical Brief for the technical brief or Design Brief for the design brief.

5. Click Next to display the Select Import Options dialog box.

6. Select Requirement as the subtype.

7. Click Finish.

The design or technical brief template is created.

8. Copy the design or technical brief template to the initiative folder.

Create design and technical brief templates by attaching a document to a package item

1. Navigate to the initiative folder.

Create a package process template
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2. Choose File→New→Item.

3. In the New Item dialog box, select Design Brief for the design brief or Technical Brief for the
technical brief.

Click Next.

4. Type the item ID, revision ID, and the item name.

Click Finish.

A new design or technical brief item is created.

5. Attach the design or technical brief template to the newly created design or technical brief item.

7. Configuring CPG
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